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1 INTRODUCTION 

1.1 X9 RCC Overview 

Remotely created checks (RCC) or demand drafts are checks that are created by or on behalf of the 

depositor and authorized by the check account holder. They are commonly used to process 

preauthorized remittance payments. With the advent of Check 21 checks can now be truncated with the 

check image and MICR data cleared in X9.37 Image Cash letter files. All My Papers (AMP) X9 RCC 

System will perform a paperless generation of X9.37 Image Cash Letters containing RCC check images. 

The X9 RCC system is the integration of proprietary and exclusive AMP Software Development Toolkits. 

AMP’s AmpLib SDK is used to generate RCC check images from text data. X9Lib SDK is used to bundle 

the RCC images into Image Cash Letter file formats compliant with image exchange or deposit formats. 

Figure 1 shows the architecture X9 RCC that is built upon AMP’s Software Development Kits (SDK). This 

is an automated solution that will import the payment file that contains all the check payment information 

details and then produce an X9.37 Image Cash Letter (ICL) that conforms to the requirements for clearing 

through the Federal Reserve Bank’s (FRB) clearing system. Additionally ICL files can be formatted for 

deposit into commercial banks. AMP technology supports deposit ICL formats for the majority of the large 

banks. 

 

 
 

Figure 1 RCC ICL File Generation System 

 

Features of this system include: 
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 Supports custom design of check images 

 Manual or automated lights out operation 

 100% configurable. No programming required 

 Supports dozens of commercial bank deposit formats 

 Capacity to generate over 40,000 RCC items in a single ICL file. 

 Generate items at over 1000 Items per minute 

 RCC images can be automatically printed if source document is required 

 Fraud deterrent feature. Depositor’s name and account number is required to be endorsed on 
check images. 
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To produce RCC check images the application imports an XML Configuration file, a text payment file, and 

a front and back check image template file. The configuration file defines the following: 

 Filenames and locations of the check image template files 

 Check image zone definitions: 

o content 

o font 

o Format 

o location 

o orientation 

 Output ICL format 

 MICR Code line formats 

 Payment file contents 

The system first generates the RCC check images. An option allows the automatic printing of these check 

images if the source document is required for any purposes. The RCC check images are then bundled 

into a X9.37 ICL format compatible for image clearing through the exchange networks. The application 

can then convert this to a commercial bank deposit format. 

The check image templates can be created with MS Word or any other document or image editing 

application. This document can be customized according to the customer’s requirements. Layout and 

graphic elements can be designed as long as they conform to industry check design guidelines. Fields 

are defined for the payment data. An E13B MICR font is provided to encode the MICR code line fields. 
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2 CONFIGURATION FILE 

The configuration file defines the format and contents of the resultant RCC check images and the format 

of the output ICL file. It is an XML format that can be edited with a text editor or an XML editor. It contains 

element sections as follows: 

 

Element RCC_PAY_CFG 

Description Defines the document type 

Attribute Description 

documenttype Defines the set of rules that the application will use to create the RCC 

document. Valid values are: 

CHECK – for creating check images 

DEPOSIT – For creating deposit ticket images 

Currently only a value of “CHECK” is supported 

Example:  

 

Element image_templates 

Description Defines the filenames and locations of the document image templates 

Attribute Description 

front Path and filename of the front image template 

back Path and filename of the back image template 

Example:  

 
 

 

 

 

 

 

Element ACCOUNT_CHECKNUM_Definitions 

Description Defines the format of the ON-US and AUX-ON-US MICR fields 

“C” – Check Number 

“A” – Account Number 

“/” – ON-US symbol (c) 

“-“ – dash (-) 
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“ “ – SPACE 

Multiple formats can be defined. Each will be selectable by the index number 

Attribute Description 

index An incrementing number for each definition. This is the number that would 

appear in the payment file to select the required format 

type Document Type: 

CORPORATE – for corporate check MICR format 

PERSONAL – for consumer check MICR format 

auxonus Defines the format for the AUX-ON-US field 

Examples: 

“/C/” – Produces – c012345c 

“” – Produces nothing 

onus Defines the format for the ON-US field 

Examples: 

“A/C” – Produces – 12345678c0123 

“C/A/” – Produces – 0123c12345678c 

“C-A/” – Produces – 0123-12345678c 

Example:  

 

Element param_definitions 

Description This section defines all the parameters that will used to create the RCC images. A 

parameter can be defined and set in the configuration file, or its value can come from the 

payment file.  

For documents defined as “CHECK” here are the parameter rules: 

There are some predefined parameters that the application is expecting. RCC images will 

not be generated if the value of these parameters is not set in the configuration file or 

provided in the payment file. The required  parameters are: 

 payee_name 

 payee_account_nbr 

 payment_amt 

 check_nbr 
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 check_type (select definition type for Account and Check Number formats) 

 bank_route – Payor Bank Routing number 

 account_nbr – Payor account number 

 reference_nbr - check payment reference number used as ECE Sequence 

The following parameters values are generated by the application: 

 MICR_ROUTE 

 MICR_AUX 

 MICR_ONUS (MICR codeline) 

 legal_amount 

 

Attribute Description 

param Name of the parameter 

cfg_file_pos Position in the payment file (1,2,3…) 

Payment file is a comma separated value file 

length_MIN The minimum expected string length of the value provided in the payment file. 

Used in validation. 

length_MAX The maximum expected string length of the value provided in the payment file. 

Used in validation. 

required Indicates if the parameter is required. If missing the application will terminate 

with an error condition. Values are “True” or “False” 

value Sets the value of the parameter. A parameter defined with a value will not exist 

in the payment file. 

Example:  



X9 RCC User Manual 2.2 

Page 7 

     All My Papers Confidential  

 

 

Element zone_definitions 

Description Defines the zones on the RCC images where information will be printed. Defines the 

location, content and format of each zone 

Sub Element front 

Description Contains the zones definitions for the front image 

Sub Element rear 

Description Contains the zones definitions for the rear image 

Attribute Description 

name Name of the zone 

view “front” – for zone on front image 

“back” – for zone on back image 

x Horizontal distance from the left side of the document image to the left side of 

the zone. Measured in inches. (E.g. 2.25 = 2.25 inches). Accuracy is 0.01 inch. 

y Vertical distance from the top side of the document image to the top side of the 

zone. Measured in inches. (E.g. 2.25 = 2.25 inches). Accuracy is 0.01 inch. 

width Horizontal width of the zone. Measured in inches. 

height Vertical Height of the zone. Measured in inches. 

textlines Number of text lines that will be printed in the zone 



X9 RCC User Manual 2.2 

Page 8 

     All My Papers Confidential  

 

font Name of the font to be used for the zone or text line. 

size Size of the font in points. 

justification Justification of the text in the zone or line. Values are “left”, “right” or “center”.  

orientation Orientation of the zone. Values are “vertical” or “horizontal”. 

bold Text will be printed in bold or normal. Values are “True” or “false”. 

Sub Element line 

Description Each zone will have 1 or more lines of text. Each line will have a line defintion. 

Attribute Description 

string This is the string contents of the line. The line can contain from 0 to 9 variables 

whose values come from the parameters. To add a variable use “%n” where n 

is the index number of the variable. The first variable will be %1, 2
nd

 will be %2, 

etc. 

Examples: 

<line string="%1" var1="payee_name"/> will print the 

string value of the payee_name. 

<line string="Void after 180 days" size="8"/> will print 

“Void after 180 days" in 8 point font. 

var1 Defines the parameter to use for variable 1. Use var2, var3, … for multiple 

variables. 

format1 Supports optional formats for date and amount fields. 

amount format values: 

                          - amount1 199.99 

                          - amount2 $199.99 

                          - amount3 *****199.99****** 

                          - amount4 $****199.99****** 

date format values: 

                          - date1 MM/DD/YYYY 

                          - date2 MMMMM DD YYYY 

Line format 

options 

Additionally for each line you may redefine: 

 font 

 size 

 justification 

 orientation 

 bold 



X9 RCC User Manual 2.2 

Page 9 

     All My Papers Confidential  

 

 

Example:  

 

Element ICL_definitions 

Description Defines the contents and format of the output ICL file. 

Sub Element x937 

Description Defines origin and destination header record contents 

Attribute Description 

Destination_routing_number 9 digit destination institution routing number 

Destination_name Destination institution name (18 digits maximum) 

Origin_routing_number 9 digit origin institution routing number 

Origin_name Origin institution name (18 digits maximum) 

Test_File “True” for test file, “False” for production file 

Destination_Format A two digit number that defines the commercial bank deposit 

format that will be produced. Contact AMP for more 

information. 

Delete_Records Removes records form the output ICL file. Some deposit 

formats require some records to not be present. 

CreditFrontImage Defines the filename and path of the front image that will be 

used for a credit item. 
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CreditBackImage Defines the filename and path of the back image that will be 

used for a credit item. 

Update_Credit_Image “True” – Annotate the credit image with deposit information 

“False” – Do not annotate the credit image (default) 

Delete_Records Record numbers to delete (usually Records 54, 28, 26) 

Comma separated 

FIRoutingNumber For Canadian deposit ICL formats this is the actual routing 

number of the depositing Institution. Can be a Canadian or 

US Financial Institution.  

Summary_Item_Include_Credit_Item ICL Control Item Totals to include Credit Items (True/False) 

Default is “True” 

Summary_Amount_Include_Credit_Item ICL Control Amount Totals to include Credit Items 

(True/False) 

Default is “True” 

  

Element setRecordField 

Description Sets the value of any text field in any record in an ICL file.  

Attribute Description 

record Record number 

field Field number 

all “True” – Set the field in all Records of this type. 

“False” – Set field in only the first Record of this type. 

value The value to set. 

afterconversion “True” – Set the value after conversion to Deposit format.  

“False” – Set the value before conversion to Deposit format. 

This is optional. Default is “False” 

Element setOneRecordField 

Description Sets the value of any text field in any record in an ICL file. Allows for 

selecting specifc items/recors in specific locations 

Attribute Description 

record Record number 

field Field number 
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cashletter Cash letter position in file  

bundle Bundle location within the cash letter 

item Item location within the bundle 

value The value to set. 

The esc sequences of: 

$DATE – replaces with the date in format YYMMDD 

$TIME – replaces with the time in HHMMSS format 

afterconversion “True” – Set the value after conversion to Deposit format.  

“False” – Set the value before conversion to Deposit format. 

This is optional. Default is “False” 

 

Example:  

 
 

3 PAYMENT FILE 

The Payment file contains the data that will be printed on to the checks. The contents are defined in the 

configuration file. This file is a text file with each parameter value separated by a comma (CSV format). 

Each value must also be delimited by double quotes. There is one line for every RCC item that is to be 

generated. Below is an example of one line from a payment file. 

 

"Check Payee 1","1234567890321654","888888888888888","1.0000","3/2/2010 12:00:00 

AM","9876","2","Abby Davis","","6548 Sterling Circle","","Lunar","WI","56789     ","Third Credit 

Union","Lunar","WI","56789     ","5555444400","069327216","800-328-7448" 
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4 CHECK TEMPLATE DESIGN 

The application requires a front and back image template for the documents you will be generating 

images for.  

The check template is used by the application to create the RCC images by adding the information 

defined in the configuration file. A check template can be created in MS Word by defining a custom 

document size (8.5 X 3.0) for the check images. Boxes, lines, text can be added as required. To create 

an image file you will need to redirect the printer output to Microsoft Document Imaging that has been 

configured to produce TIFF images at 200 DPI resolution. Refer to section 9 for details on setting up 

Microsoft Document Imaging. 

Figure 2 and Figure 3 show the check template design. 

 

 

Figure 2 Check Template - Front View 

 

 

Figure 3 Check Template - Rear View 
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5 PLATFORM REQUIREMENTS 

5.1 Hardware Requirements 

This section describes the minimum required hardware platform to operate the X9 RCC system achieving 

the performance objectives. The customer is responsible for providing this hardware platform. This is 

based on a typical volume of 500 items per day, with a peak volume of 2000 items per day. 

 

Windows PC/Server 

 Single Processor, 2 GHz 

 1 GB RAM 

 60 GB Hard drive for Operating System and Application 

5.2 Software Requirements 

This section describes the software platform requirements. The customer is responsible for providing the 

platform environment. 

Operating System: Windows (XP, Server 2008-12, Windows 7/8) 

6 INSTALLATION 

6.1 X9 RCC Runtime License 

AMP will provide a set of license codes that will need to be installed on the operating platform. This 

requires the AMP License Manager to be downloaded and installed from: 

http://www.allmypapers.com/license_manager.htm. 

6.2 X9RCC Installation 

This is a self installing executable that is part of the deliveries. 

6.2.1 Files and Directories 

The X9 RCC program files will be installed in the directory structure as shown in Figure 4. AMP will 

provide a self installing executable that will create the required directories and install the files. 

http://www.allmypapers.com/license_manager.htm
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Figure 4 X9 RCC Installation Directories 

 

The directories are for the following files: 

X9RCC – Contains the application and runtime files 

Config Files – Contains a sample configuration file.  

Payment Files – Contains a sample payment file. 

Templates – Contains sample check image and deposit ticket templates 

Help – Contains the Users manual  

Additionally the following files will be installed on the file system: 

 MICR font file “MICR.ttf” will be installed in “C:\WINDOWS\Fonts”. This enables MS Word to print 

the MICR code line on the check images 
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The application will create additional directories to operate. A working directory called X9RCC will be 

created in the application data directory. See Figure 5 below. 

 
Figure 5 Working Directories 

The directories are for the following purposes: 

X9RCC – The output ICL file will be put here by default unless specified differently. Intermediate 

files are also created here. The application will also create a log file here. 

RCCimages – The generated RCC images will be generated in this directory unless specified 

differently. 

X9LIBWorkDir – This is a directory the application uses to process. If anything goes wrong there 

are log files available here that can be used to diagnose the issues.  

 

7 SETUP 

This section describes the additional setup procedures that can be performed after installation to 

configure the desired operation 

7.1 Output Options 

With the application started select the menu item Configuration – Output Options 
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Figure 6 Configuration Menu 

 

The Output Options screen will be displayed 

 

Select RCC Image Directory – This is the directory location that the application will generate the RCC 

check images. Select a new directory if you do not want to use the default directory. The application will 

erase the images prior to each new job.  
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Select ICL Output Directory - This is the directory location that the application will create the final ICL file.  

Select a new directory if you do not want to use the default directory.  

Bundle Limit – Select a bundle limit if you want the application to control the maximum number of items 

that can be placed in a single bundle. Value must be from 1 to 9,999. Leave blank if you do not want to 

limit bundles.  

Print RCC Documents – Select this if you want the application to automatically print the RCC document 

images. 

Call External Process on Completion – Select this if you want to invoke another process upon 

completion of the generation of the ICL file. 

Select External Process – Use this to select the external process to be invoked. This process will be 

called with the ICL pathname as the first argument 

Command Line Arguments – You can add additional arguments if required for the external process call.  

Select “Save” to store the new settings. 

Enable EPC Code “6” for RCC Items – In 2015 the FRB requires RCC items to have an EPC code of 

“6” applied to identify them as RCC items. 

 

7.2 Application Locations 

X9 RCC can invoke two additional applications. It can invoke an application to print the RCC images 

(PrintBatch) and it can invoke the X9 Viewer application to view the contents of the ICL files.  

To use these functions requires the installation of: 

 XipPrint Application 

 X9 Viewer Application 

Nothing needs to be done if these applications are installed in the default locations.  If they are installed in 

non standard locations then the application allows you to define the new location. 

With the application started select the menu item: Configuration – Application Locations 
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Figure 7 Application Locations Form 

Browse to the new application locations and close the form. Close the form and application to save the 

settings.  

7.3 PrintBatch Configuration 

To print RCC images from the application requires the configuration of the PrintBatch.exe utility located in 

the XipPrint application directory. See Figure 8. 

 

 
Figure 8 PrintBatch Utility 

 

To use PrintBatch you must first configure XipPrint to use the required printer. Refer to help materials on 

installing and using XipPrint.  
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To configure PrintBatch run the utility and select the menu item: File -> Printing Options. Configure the 

Printing Options form as shown in Figure 9. 

 
Figure 9 Printing Options Form 

 

Select the active printer for your configuration. 

 

8 OPERATIONS 

8.1 User Interface Operations 

Figure 10 shows the main operation’s screen.  
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Figure 10 Main Screen 

 

Payment File – Select the payment file that contains the item payment data to create RCC images form. 

Configuration File – Select the configuration file that contains the definitions for the RCC images and 

ICL output file formats.  

Generate RCC Button – Select to start the generation of RCC images and creation of the RCC ICL 

output file. 

 

After processing is complete the screen will look like Figure 11. Progress is shown during processing. The 

screen will list a summary of the output file created.  
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Figure 11 Processing Complete 

 

View ICL – Select to invoke the X9 Viewer to view the output ICL file. 

Clear Form – Select to clear this form. 

 

8.2 View Menu 

Figure 12 shows the View menu. You have 4 options: 

ICL File – View the generated ICL file with the X9 Viewer application.  

Configuration File – View/edit the configuration file. 

Payment File – View the payment file. 

RCC Log File - View the job log file. This will normally contain a summary of the file just generated. If an 

error occurred during processing then this file will contain additional information on the error.  
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Figure 12 View Menu 

8.3 Automatic Operations 

The X9 RCC can be invoked as a command line function.  

Command line syntax: 

X9RCC <payment file path> <configuration file path> 

For Merging Cash Letter Files 

X9RCC –M <merge list pathname> <output ICL pathname> 

Where the merge list file is a list of the ICL files to merge (1 per line) 

It is recommended to delimit the arguments with double quotes to prevent problems with space 

characters in the pathnames. 

 

9 MICROSOFT DOCUMENT IMAGING SETUP 

Microsoft Document Imaging can be used to TIFF image template files from MS Word document design. 

This application needs to be manually setup to save output as TIFF images.  

1. Locate and run “Microsoft Office Document Imaging” application. It should be located in 

C:\Program Files\Microsoft Office\Microsoft Office Tools 
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2. Select Menu item Tools -> Options, and select the “Other” tab. 

 

3. Select File Import preferences. 
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4. Set TIFF – Monochrome Fax, Fine (200DPI) 

5. Set “Default Folder” to the application directory you will be using for creating the RCC ICL files. 

6. Click “OK”, “OK”, and close Microsoft Office Document Imaging. 
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APPENDIX A SAMPLE OF PAYMENT FILE 

 

 


